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An Overview of Mindjet Power Markers 

Mindjet Power Markers™  is an extension for Mindjet MindManager that is perfect for 

creating dashboard maps to keep you up-to-date and in control of projects, meetings and 

much more. With a dashboard map, you can easily keep track of your progress and focus 

on what needs your attention next. 

Power Markers is primarily valuable for generating lists of the topics in your maps, called 

Hot Lists, that can help you to find and use essential information more quickly. Once you 

have designated which marker groups to track, the Hot Lists task pane shows you all the 

topics on your map that use these markers, organized by individual markers.  

 

Power Markers features are automatically integrated into MindManager, and offer these 

additional capabilities: 

 Use Roll-up markers to indicate that a marker exists within the branch, even when 

the topic containing it is not exposed. 

 Create Automatic markers that are applied or removed based on a specific condition 

(for example, if the due date is this week). 

 Use Active legends map parts, that let you define markers directly on the map. 

 Choose from a selection of map parts with pre-defined active legends and automatic 

markers  

The quickest way to understand what Power Markers does is to see it in action. Power 

Markers contains a built-in demonstration template map that you can experiment with, and 

you can watch the Power Markers Overview video here. 

http://mindjet.com/support/tutorials/powermarkers
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Getting Started 

Power Markers features 

Mindjet Power Markers adds new features to the MindManager interface in these locations: 

Ribbon 

Power Markers adds its own command buttons to the MindManager Ribbon's View tab. The 

Power Markers buttons let you enable or disable Power Markers in the current map, 

configure the markers for the map, update the markers on your map, and access help and 

support. 

Task Panes 

MindManager's "task panes" are the tabbed panels by the side of your map such as the 

Task Info task pane. 

Power Markers  adds its own task pane, called the Hot Lists. This is the primary interface 

for Power Markers, and the place where you will access summarized and sorted lists 

generated from your map. The Hot Lists task pane maintains lists of topics organized by 

their markers, so that you can quickly see how many topics in the map possess a specific 

marker, and go straight to them by clicking on their text in the Hot Lists. The Power 

Markers command buttons are also available in the Hot Lists, so that you don't have to 

keep switching to a different tab when you are working on your map. 

Power Markers also adds a set of Map Parts to the Map Parts task pane, and adds some 

Icons in the Library task pane. 

Options 

In the MindManager Options, Power Markers adds its own Options page, where you can 

control some of power markers behaviors. For example, you can choose whether the Power 

Markers splash dialog appears when MindManager starts. 

The Power Markers add-in is listed on the MindManager Options Add-Ins page, and you can 

enable or disable the entire add-in from there. 

Marker behavior 

Power Markers adds some special information to the map's Marker Groups, called the 

Group behavior, so that it knows how to handle each group. the Group Behavior for each 

marker group is defined in the Power Markers Configuration dialog. This tells Power 

Markers whether to simply ignore this group or process its markers in a special way, by 

rolling them up in the map, or adding the topics that use them to the Hot Lists. 

Power Markers also adds the concept of Automatic Markers to the Markers themselves - 

any marker can be automatically associated with a special condition on a topic, exposing 

more information from your map. 

Maps 

Power Markers installs a set of Template Maps, which help you to create powerful 

dashboard maps without starting from scratch. 
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When Power Markers is active, it can add dynamic information to your maps by rolling up 

certain markers. This makes information buried deep in the map more visible by bringing it 

into view, at or around the central topic of the map. This is called the Roll-up feature. 

Power Markers also makes it possible to define the marker set visually, from the map 

itself. If you have used MindManager's markers, you may have used the "Legend" feature, 

which takes the current marker set and draws a legend in the map. Power Markers adds a 

new dimension called Active Legends, which works the other way around; you specify the 

groups and markers that you want to use by mapping them out visually, then this 

configuration is used to define the markers list for this map. This is more flexible and 

quicker than editing the list in the Markers task pane. 

The Active Legend feature adds a new command to the topic context menu in your maps, 

to convert a topic into an Active Legend topic. 
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Power Markers buttons 

The MindManager Ribbon's View tab and the Hot Lists task pane offer the same set of 

buttons to control Power Markers. You can use whichever is more convenient. 

 
Power Markers buttons in 

the MindManager ribbon View tab 

 
Power Markers buttons in 

the Hot Lists task pane 

The Configure, Enable, Update and Auto buttons are only active if there is a map open. 

The Configure button 

The Configure button allows you to configure the behavior of the Power Markers in the 

current map. 

When this button is flashing, it means that Power Markers has detected a change in the 

Marker Set on the map. Power Markers must be disabled and then enabled so that the 

latest Marker Set is used. This can happen if you edit the Marker set while Power Markers 

is active and in auto mode. 

The Enable button 

The Enable button turns Power Markers on or off. 

When Power Markers is first enabled, it scans your map, adds or removes Markers as 

needed, and generates the Hot Lists information. When the Enable button is active, if any 

of the Marker groups are configured for Roll-up behavior your map will contain 

automatically-generated Markers . If you save the map with Power Markers enabled, it will 

save the automatic Markers as well. You can send a copy of a MindManager map to 

someone who does not use Power Markers, and they will still see the automatic markers, 

although they will not see the Hot Lists. 

When you click this button to turn off Power Markers the automatically-placed Markers are 

removed, returning your map to its original status. 

The Update button 

Clicking the Update button when Power Markers is not enabled has the same effect as 

clicking the Enable button. Power Markers switches on, scans your map and applies the 

automatic Markers. 

Clicking the Update button when Power Markers is already enabled refreshes the automatic 

markers in your map and the Hot Lists. Using the Update button is an alternative to using 

the Auto button. 



Getting Started 

 User Guide - 5 

The Auto button 

The Auto button switches on continual updates by Power Markers. In this mode, every time 

you make a change to the map, the automatic Markers and the Hot Lists are refreshed. 

This is the most convenient way to work, so most of the time you will only use the Auto 

button and Enable button to switch Power Markers on and off respectively. If you plan to 

make large-scale changes to a map, such as copying and pasting complete maps, it is 

better to turn off Auto mode, as this can affect MindManager's performance. You can then 

use the Update button to update the map when it is convenient. 

If you save your map with Auto mode enabled, it will be switched on again the next time 

you open the map. 

The Enabled and Auto status of Power Markers applies only to your current map, so if you 

are working on multiple maps, you will need to switch Power Markers on in each map. Note 

that each map may have a different set of markers configured as Power Markers, so the 

Hot Lists will change when you select a different map. 
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Tutorial: Power Markers demo 

The quickest way to understand what Power Markers does is to see it in action. Power 

Markers contains a built-in demonstration template map that you can experiment with and 

reuse to create maps as often as you like. 

1.      Once you have installed Power Markers, the Power Markers Demo 1 template 

appears in the selection of templates available in MindManager. Begin a new map 

using this template. 

 
You can experiment with this map freely without effecting the original template. 

 
Power Markers demonstration dashboard 

On this map, some of the topics are marked as actions, some have dates on them, and 

some are owned by different people. Power Markers can help you determine what's 

important, and what needs attention. 

2.       In the Power Markers group on the Ribbon View tab, click Auto. The Enable and Auto 
buttons are activated to show that Power Markers is in Auto mode. 

3.      The map will change to highlight two of the main topics: 
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Demonstration dashboard with Power Markers in Auto mode 

Power Markers is indicating that two areas of the map require attention - one urgently 

(in red) and one less urgently (in green). 

4.      By inspecting the branch with red highlighting you will find that there is an incomplete 

task, ("Call accountant...") that has a due date of yesterday. Power Markers is warning 
you that this action is overdue. 
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An overdue incomplete task causing red highlighting (the dates in your sample will vary) 

5.      Click the Progress icon on this topic three times, until it changes to 100% complete, 

indicating that you have done this task. The red highlighting disappears, as there are 

no more overdue tasks, and is replaced with orange highlighting: 

 
Overdue task cleared by completing it 

The orange highlighting indicates that there are some incomplete tasks due within the 

next three days. The green highlighting indicates that there are some incomplete tasks 
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due within the next four weeks. (You can define your own conditions for applying 

highlighting - these are only examples). While there are both orange and green 

highlights in this part of the map, the orange takes priority as it represents more 

urgent actions. You will see how and where this is defined later on. 

6.      Power Markers can also provide a different view of these tasks, organized by marker 
or other conditions. Click the "Hot Lists" tab to display the Hot Lists task pane. 

 
The Hot Lists task pane with Power Markers in auto mode 

7.      In the Hot Lists pane, click the + next to Deadlines, and open the section "In next 3 

days". Click on "Treasurer's report", and Power Markers will select that topic in the 
map: 
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Selecting a topic in the map by clicking on it in the Hot Lists 

Power Markers has made a list all the unfinished tasks that are dated for completion 

within the next three days. The Treasurer's report is due tomorrow, so is highlighted 

for your attention today. Clicking on a topic in the Hot Lists task pane will select it in 

the map, so you can use the Hot Lists to quickly navigate to items in the map that 

require attention. If you set the Treasurer's report topic to 100% complete in the map, 

it will disappear from the Hot Lists, as the Hot Lists task pane is set to hide completed 

tasks. 

8.      Browse the other lists in the Hot Lists task pane to discover: 

 Who is responsible for what (under "People") 

 Things you are waiting for (under "Actions" > "Waiting for reply") 

 Whether the map contains any attached documents (Under "Assets" > 

"Attachments") 

9.      Power Markers has an Automatic Marker feature that can create lists based on defined 

conditions in a topic. There are over 190 different conditions that it can detect, 

including specific text fragments in the topic text. Try the following: 

 Add a topic anywhere in the map, and make it a question, with a question mark (?) 

at the end of the topic text. Power Markers will add the Question icon to the topic, 

and the topic will be added to the Hot Lists under Issues > Questions. 

 Add a topic anywhere in the map, and include the text "@david" (without the 

quotes). For example, Update accounts @david. Power Markers will strip the 

"@david" key and will replace it with the marker for David Roberts. The topic will be 

added to the lists under People > David Roberts in the Hot Lists. 

These key texts make it easy to quickly add topics to specific lists, just by typing 

certain text. (One of the other Power Markers dashboard templates detects the word 

"Call" at the start of a topic, and adds a marker for phone calls). 
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10.   To see how all this behavior is configured, go to the Hot Lists and click on Assets > 

Bookmarks > Active Legend. Power Markers will take you to a (previously filtered out) 

floating topic in the map, where the markers and their behaviors are defined in an 
"Active Legend" tree: 

 
The Active Legend topic, where markers and their behaviors are defined 

The Active Legend function in Power Markers lets you plan out your marker groups, 

marker names and their behaviors visually in the map. The markers are updated by 

clicking the green "refresh" arrows  on the Active Legend topics. 

Active Legends make it easy to transfer sets of markers from one dashboard to 

another, to reuse sets of markers, and to change group and marker names. Try 

changing the text on the "New tasks" topic, then click the green refresh arrows on the 

"Actions" topic. Power Markers will prompt you for permission to update the markers. 

When you look in the Hot Lists or the Markers task pane, the name for the marker will 

have changed. 

Some of the markers have extra text after them, such as "In next 3 days 

$task:date:3:day". The text after the $ sign is an automatic marker condition. 

"task:date:3:day" is shorthand for the following: 

 The topic must be a task (marked with a progress value) 

 If it has a start date, then the start date must be between now and 3 days time 

 If it has a due date, then the due date must be between now and 3 days time 

If the topic meets the above conditions, then the marker is applied to it. In this 

example, the marker is an orange highlight. You can check what kind of marker is 
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applied by clicking the green arrow on the "Deadlines" topic - this shows that the 

marker type is a Fill Color. In this way, you can define how Power Markers adds 

information to your map that can be used to alert you to specific conditions. 

11.   You can close this map without saving it, or you can save it and look again in a few 

days to see what has changed. In a few days, actions that are due soon will become 
overdue, and will trigger even more red highlighting in the map. 

You can copy this Active Legend topic to another map, make a few modifications to the 

markers (such as changing the names of the people), and you are up and running with 

powerful dashboard maps. The rest of the documentation explains how this works in more 

detail, and how to design your own dashboard maps. 

The demonstration map is an example created using the GTD Dashboard template, which 

is included with Power Markers in Standard and Enhanced versions. 

 

 

Getting support 

To access on-line help and support: 

 In the Power Markers command group or in the Hot Lists task pane click the About 

button to display the About dialog. 

o Click Help to see this Help file. 

o Click Purchase to purchase a Mindjet Power Markers license. 

o Click Support to access on-line support. 

If you are experiencing problems, please be sure to give your version of Power Markers 

and version of MindManager to the support representative, as this will help to identify 

issues. 
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Using Power Markers 

Configuring Power Markers groups 

For a map's markers to behave as Power Markers, they must have their group behaviors 

configured. 

There are two ways to configure this behavior: 

 in the Configuration dialog (described below) 

 by using Active Legends in your map. 

The group behavior settings are stored in the map's Markers List. If you are familiar with 

the Markers task pane, you may have noticed some characters appearing at the end of the 

marker group names: * (asterisk) to display a group in the Hot Lists, + (plus) to roll up 

the highest ranked marker, - (minus) to roll up the lowest ranked marker, and = (equals) 

to combine markers. This is how Power Markers remembers how to process the marker 

groups. 

These settings can be exported with a Marker List for use in other maps. Refer to the 

MindManager documentation for information on working with Marker lists. You can design 

a set of markers and their configuration as Power Markers, and save it as a Marker List for 

use in other maps as well as the original map. 

Use the Configuration dialog to configure Power Markers settings 

Click Configure in the Power Markers group on the Ribbon, or in the Hot Lists task pane to 

configure the Power Markers for the current map. 

You'll see the Configuration dialog with the following options: 
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The Power Markers Configuration dialog 

Roll up to Central Topic 

If checked, any marker groups that are configured with roll-up behavior as Power Markers 

will be rolled up to the Central Topic instead of only to the Main Topics. This means that 

the Central Topic may have multiple different markers on it, so it can become overloaded if 

care is not taken. Since the Main Topics are almost always in view anyway (unless filtered 

out), it is not usually necessary to roll up markers to the Central Topic. The default setting 

for this option is off. 

Include Map Markers from filtered-out topics 

If not checked, Power Markers will only include topics that have not been filtered out. This 

is the default setting. If checked, Power Markers will also keep track of markers in topics 

that are hidden by a filter, either by MindManager's Power Filter or Show Branch Alone 

features. you can read more about using the Show Branch Alone function with power 

Markers here. 

Import Orphan Markers 

Imports any orphan or unnamed markers into your Markers List before using them as 

Power Markers. Normally, you only need to do this on maps where icons and text markers 

or tags have been added without naming them in the Markers List. This process is 

described in more detail here. 

Automatically include orphan Resource and Color Markers 

With this option enabled, Power Markers will automatically include all Resource markers, 

Category markers, Fill Color markers and Font Color markers in your map, even if they are 

unnamed in the Marker List. This is the normal setting. This allows you to use these 

markers without needing to also visit the Markers task pane to name them. If you want 

Power Markers to only track named markers included in the Marker List, you can uncheck 
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this option. The reason that these particular markers types have been selected is that (a) 

these Marker groups are always present in the Marker list, and (b) there are ways to add 

these marker types to a map without using the Marker list. 

Note that if the color markers are automatically detected in the map, then their order is 

not controlled. If you need the markers to be listed in a specific order, then this option 

should be unchecked and they should be enabled in the Power Marker by group table 

(described below). 

Ignore legend topics that define markers 

This option controls whether Power Markers will display Active Legend topics in the Hot 

Lists. Normally, you would have this option enabled, and override this setting for individual 

topics as described in Advanced Active Legends. 

Power Marker behavior by Marker group 

The table lists the Marker groups present in the current map, how many markers are 

present in each group, and the status of the Mutually Exclusive setting for that group. 

(Mutually Exclusive means that only one marker at a time from the group can be present 

on a topic). Some groups are naturally mutually exclusive, and the setting cannot be 

changed; for example, there can only be one fill color at a time on a topic. 

The behavior setting for each group can also be configured in the Active Legends. If you 

change the configuration in this dialog, it will also update the Active Legends in your map. 

For each Marker group, you can select the way it behaves as a Power Marker group: 

None 

This group is ignored by Power Markers. Its markers are not rolled up or shown in 

the Hot Lists. 

Track in Hot Lists only 

The markers in this group are shown in the Hot Lists task pane, but are not rolled up 

in the map. 

Roll up highest marker (+) 

The group is shown in the Hot Lists task pane, and the highest ranking marker in this 

group is rolled up to the Main Topics (or Central Topic). "Highest ranking" refers to 

the order in which the markers are displayed in the Markers task pane. Higher 

ranking markers take precedence over lower ranking markers. This allows you to see 

the "best case" status of topics on your map. 

Roll up lowest marker (-) 

This works in the same way as rolling up the highest marker, except that lowest 

ranking marker in the group takes precedence. The group is also shown in the Hot 

Lists. This allows you to see the "worst case" status of topics on your map. 

Roll up average value / combined markers (=) 

The group is included in the Hot Lists, and a derived marker is rolled up to the center 

of the map. This setting works is not available on all marker types. For Progress 

markers, this configuration calculates the average progress of the tasks in the tree 

and rolls up that value. So if you have a topic with four task subtopics, of which two 

were started and two finished, then the average progress rolled up to the parent will 

be 50%. For other types of marker, Power Markers will combine resources or 

markers together, unless it is a mutually exclusive group. 

Clear all button 

Resets the configuration settings and start over. 
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Save as Default button 

Saves the displayed configuration as the default. The default configuration is used when 

Power Markers does not find a customized configuration for a map. The mandatory marker 

groups (that are present in every map and cannot be deleted) are automatically shown in 

the Hot Lists task pane. You can change this configuration and save it as the new default if 

you want specific group behaviors without needing to configure each map. You can even 

include custom marker groups in the default, and they will be ignored if not present in a 

map. 

The "Mutually Exclusive" settings are not included in the saved default configuration. 

Note that clicking this button does not apply the current configuration to the current map. 

You must click OK to do that. 

If you don't want Power Markers to use a default configuration, click Clear all followed by 

Save as Default. You can then click Cancel to avoid overwriting the configuration of the 

current map. 

OK button 

Saves the Power Markers configuration. If Power Markers is in Auto mode, then the map is 

automatically refreshed. Otherwise, you will need to click the Update button. If you are 

using Active Legends in your map, then the behavior and mutually exclusive settings for 

each group are also updated on the Active Legend topics. 

Cancel button 

Closes the dialog without saving any changes to the Power Markers configuration. 

However, if you imported any orphan or unnamed markers to the Markers List for this 

map, then clicking Cancel will not abandon the imported markers - they will remain in the 

Marker List. 

Edit the map's Marker List 

The Power Markers configuration depends on the current Marker List that is associated with 

the current map. What happens when the map's Marker list is modified, either by editing it 

in the Marker task pane, or by applying a new Marker list from the Tools menu in 

MindManager? 

 If Power Markers is not enabled, the new Marker List will be loaded again the next 

time Power Markers is enabled. 

 If Power Markers is enabled or in Auto mode, the Configure button will start to 

flash. 

This means that Power Markers is still using previous Marker List and has not been 

refreshed. To use the modified Marker List, either click the Enable button followed 

by the Auto button again, or click the Configure button to update the Power 

Markers Configuration. 

Generally, while Power Markers is running in Auto mode, it is better not to edit the Markers 

List in the Markers task pane or apply a new Markers List . 
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Working with the Hot Lists 

The Hot Lists task pane is displayed either by clicking the Hot Lists task pane tab, or by 

choosing it from the task panes button in the MindManager status bar (at the bottom of 

the MindManager window). It shows a list of topics that carry each marker in the Marker 

groups that are configured for display in the Hot Lists. 

 
The Power Markers Hot Lists task pane 

 To see Hot Lists in action, try the Hot Lists tutorial. 

The buttons at the top of the Hot Lists task pane work in the same way as the buttons in 

the Power Markers command group in the Ribbon, and are described here. You can hide 

them by clicking Hide Mindjet Power Markers buttons.  

The Hot Lists are only visible when Power Markers is active. If the Hot Lists are not visible, 

then click the Enable or Auto buttons to switch them on. If they are visible but empty, 

then either none of the Marker groups have been configured as Power Markers, or there 

are no topics in the current map that carry any of the Power Markers in an active group. 

Click Configure to configure the Power Markers for this map. 

The primary organization of the Hot Lists is by Marker Group, in the same order that 

groups are displayed in the Markers task pane. This order cannot be changed. When you 

hover over a Marker Group entry in the Hot Lists, it shows you how many Markers it 

contains: 
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Display of marker count in a Marker group 

Clicking on either the [+] box next to the Marker Group name, or on the group text, will 

expand this group. If it is already expanded, then clicking on the [-] box or the group 

name will collapse it again. 

When a Marker group is expanded in the Hot Lists, it shows the Map Markers that are 

currently used in the map. These are shown in the same order as the Markers task pane: 

 
Markers currently in use in marker group 

There may be more markers in the group that are not currently used. We will see how to 

display these later. An icon is shown for each marker, corresponding to the icons used in 

the Markers task pane. Hovering over a Marker in the Hot Lists displays the group to which 

it belongs, and the number of topics in the map that have this marker: 

 
Display of topic count for a Marker 

Clicking on the [+] next to the marker name, or on the marker text, will expand the 

marker to show the topics that carry this marker. Topics are listed in alphabetical order, 

regardless of where they occur in the map: 
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Topics expanded for a Marker 

The tool tip shows the Marker carried by the topic, and also the full topic text. You can 

make the Hot Lists task pane wider by dragging the bar that separates it from the maps 

area, or you can scroll the Hot Lists sideways, but often it is just as convenient to hover 

over the entry in the Hot Lists to read the full text. Clicking on the entry for the topic will 

select or focus on that topic in the map (as configured in the Power Markers Options) and 

scroll the map so that the topic is in view. Note that the Hot Lists only show topics that 

carry "original" markers added by you. Topics that include generated roll-up markers are 

not shown in the Hot Lists. 

 

Edit Power Markers on topics 

Check this option if you want to add or change markers on the map from the Hot Lists. 

With this check box enabled, the Hot Lists display all the markers in each Marker Group, 

not just the markers that are currently in use in the map. Clicking a marker in the Hot Lists 

will change the marker on any topics that are currently selected in the map. 

Hide completed tasks 

It is common for dashboard maps handled with Power Markers to contain actions, marked 

with the Progress icon on a topic. Most of the time, you are only concerned with topics that 

are incomplete. Use this option to hide any tasks that are 100% complete in the Hot Lists. 

Exceptions: (a) the Progress marker group, where completed tasks are still listed under 

the 100% complete marker, and (b) any marker that uses the $task:complete automatic 

marker condition. 

Copy the Hot Lists to Clipboard 

Clicking this link will make a copy of the current Hot Lists on your Clipboard, which can 

then be pasted into a text document or into a MindManager map. 
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Optimizing topic text for use in Hot Lists 

When using the Hot Lists, think about the topic text that you use. The Hot Lists are always 

sorted alphabetically. Using a helpful word at the start of the topic text will make it much 

easier to find things in the Hot lists. For example, the following topics will be harder to find 

in an alphabetically sorted list: 

 Send John an email 

 Let Alan know about new budget 

 Sasha needs supplier contract 

Instead, write them so that they can be more easily located, and are grouped together in 

the Hot Lists: 

 Email John about.... 

 Email Alan about new budget 

 Email Sasha with supplier contract 

If you want to force a topic to always be shown at the top of its list in the Hot Lists, prefix 

the topic text with a punctuation character such as the underscore (_). 
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Tutorial: Hot Lists 

This tutorial will show you how the Power Markers Hot Lists feature works, making key 

information visible and actionable. 

1.      Start a new map, and add some topics marked as tasks at different stages of 

completion. They don't have to be identical to the example below - if you prefer, use 

something that is relevant to you. 

 

2.      Click the Hot Lists tab to view the Power Markers Hot Lists task pane. 

3.      Now click the Auto button in the Hot Lists task pane and the Hot Lists for this map will 
appear: 

 

4.      The Hot Lists show the Progress marker group, because it is enabled in the default 

Power Markers configuration. (Power Markers allows you to choose which Marker 

Groups to use in the Hot Lists). Click the [+] or the "Progress" text to expand this 

marker group. The Hot Lists show only the markers from this group that are currently 
used in the map: 
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5.      Click on the [+] next to the marker, or the marker texts themselves to expand the list 

of topics that carry this marker. This gives you a list of topics organized by marker: 

 

 

6.      Click on one of the topic items in the Hot Lists, and it will be selected in the map. If it 
is not in view at the time, Power Markers will expand the map to bring it into view. 

7.      Right-click on the Progress icon on one of your action topics in the map, and change it 

to "Task done". It will move from under its existing heading in the Hot Lists and 
reappear under the "Task done" heading. 

8.      Click the link Copy Hot Lists to Clipboard. This gives you a text version of the 

current Hot Lists. You can even paste it into a document or email, or into a 

MindManager map to give you a visual summary of the key information in your map. 

9.      Normally, the Hot Lists only show the markers that are actually used in the map. What 

if you want to add a marker to a topic from the Hot Lists? Click the Edit Power 
Markers on topics check box at the bottom of the Hot Lists task pane. 

10.   The Hot Lists now show all the markers in the enabled marker groups, not just the 

markers that are currently used in the map. Unused markers do not have any topics 
shown under them: 
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11.   You can now change the Power Markers on the map from the Hot Lists pane. Select a 

topic in the map, then click one of the Power Markers (e.g. "Quarter done") in the Hot 

Lists pane. It will toggle this marker on the selected topic or topics. 

12.   Add Resource names to some of the actions on your map, using the Task Info task 

pane. The Resources will appear in the Hot Lists. You will then be able to see a 

convenient list of who is doing what, regardless of where the information is buried in 
your map. 

13.   Note that the Power Markers buttons in the Hot Lists task pane mimic the ones in the 

MindManager Ribbon. You can use either set of buttons at any time, depending on 
which is more convenient. 

The Hot Lists feature can be used in many ways, to turbo-charge your use of 

MindManager maps. Here are just a few ideas: 

 If you use MindManager for a brainstorm session, you could indicate "Strengths", 

"Weaknesses", "Opportunities" and "Threats" using icons throughout your map. 

There is no need to organize the topics. Configure the marker group for display in 

the Hot Lists, and the Hot Lists pane will show you a neatly organized SWOT list for 

your whole map, regardless of how the topics themselves are arranged. See how to 

do this here. 

 If you use MindManager to capture a meeting with follow-up actions, assign tasks to 

people as you go. The Hot Lists will show the list of tasks organized by person. 

Export the Hot Lists to an e-mail and send everyone the list of follow-up actions, 

and then review them again at the next meeting. See how to do this here. 

 If you use MindManager to write specification documents, organize information, or 

keep track of issues, the Hot Lists provide a convenient way to see a summary by 

markers. For example, it could create lists of the Essential, Optional and Future 
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Features referenced in a specification document, although they may be very 

differently organized in the map itself. 

 You could code "Read me first" or "Review" topics in your map with markers, so 

that important information and summary topics are very easy to find from the Hot 

Lists. 

 You could put an invisible marker on favorite topics in a densely-populated 

information map, and use the Hot Lists for quick shortcuts around your map. See 

how to do this here. 

Read more about working with the Hot Lists feature here. 
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Working with the Roll-up feature 

Mindjet Power Markers rolls up markers to make them visible even when the map is 

collapsed to hide some levels of topics. To do this, it makes copies of markers on the 

parent topics, all the way up to the Main Topic (or to the Central Topic if configured). Roll-

up markers are generated only for markers that belong to groups configured with roll-up 

behavior. 

Normally, a marker indicates that some condition exists on this topic. Roll-up markers 

generated by Power Markers are different - they indicate that one or more topics in this 

branch contain this marker. 

Roll-up example 

 
The $ icon applies to Topic 4a 

 
Power Markers adds "signposts" with extra $ icons 

The marker group that contains $ icon has been configured with Roll-up group behavior, 

and the $ icons on the Main Topic, Topic 2b and Topic 3c were automatically generated by 

Power Markers. The automatically-generated markers are displayed only when Power 

Markers is enabled. 

Power Markers can roll up the following marker types: 

 Progress markers (if the MindManager Project Task Management add-in is not 

active) 

 Task Priority markers 
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 Task Resource markers 

 Tags (Text markers) 

 Icons 

 Topic fill colors 

 Topic text colors 

Of the above, the following markers are always "mutually exclusive", meaning that only 

one marker in the group can be used at a time on a topic: 

 Progress 

 Task Priority 

 Topic fill color 

 Topic font color 

The other marker types can be either mutually-exclusive or can be set to use more than 

one marker on the same topic. Power Markers can roll up multiple markers in the same 

group if it is not a mutually exclusive group, and can roll up markers from different groups 

at the same time. If you are going to use Power Markers to create status dashboard maps, 

it is advisable to limit the number of different markers that you roll up, otherwise the Main 

Topics or Central Topic can become overburdened with too many markers. 

What happens if you use the same marker, or another marker from the same mutually-

exclusive marker group, higher up in the same tree? 

 
How will Power Markers cope with an existing marker in the tree? 

In the above example, the $ icon already exists higher up in the tree. When the Roll-up 

feature is activated, Power Markers will want to create signposts from Main Topic 1 down 

to Topic 4a. This will involve adding a $ icon to Topic 2b, but one already exists on there. 

The same could apply when rolling up any kind of marker. 

When this situation arises, Power Markers stops and displays a message that allows you to 

choose how to proceed: 

Overwrite - overwrites this particular marker and continues 

Overwrite All - overwrites this marker and all others where necessary and continues 
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Cancel - Stops the Roll-up process 

If you want to disable this warning, you can un-check the "Warn me..." option before 

clicking either the "Overwrite" or "Overwrite All" buttons. You can also disable or enable it 

in the Power Markers Options. 

To try out this feature yourself, see the Roll-up tutorial. 
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Tutorial: Roll-up behavior 

This tutorial will show you how Mindjet Power Markers rolls up markers so that you can see 

them at the highest level in your map. 

1.      Begin by starting a new blank map in MindManager, and add a Main Topic and two 
levels of subtopics: 

 

2.      With Subtopic B selected, apply the green flag icon using commands on the 

MindManager Ribbon. 

 

3.      Next, we need to tell Power Markers that we want to roll up the Marker group that 

contains the flags, so that we can see them at the Main Topic level in the map. Click 

the Configure button in the Power Markers command group on the Ribbon. 

In the Power Markers Configuration dialog change the Power Marker behavior setting 

for the "Flags" group to Roll up highest Marker, and then click OK. Notice that some 
of the other groups are already configured, as part of the default configuration. 
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4.      Now click the Auto button in the Power Markers command group. 

 

Power Markers automatically updates the markers. In the map, the green flag icon will 

be repeated on the parents of Subtopic B, up to the Main Topic: 

 

5.      Click the Power Markers Enable button to turn Power Markers off. It will remove the 

roll-up icons that it added. Click the Auto button again to restore them. You can save 
your map with the Power Markers either applied or removed. 

6.      With Power Markers in Auto mode, right-click on the green flag icon on Subtopic B 

and choose Remove. Power Markers will automatically remove the copies of the green 
flag icon from the parent topics. 

7.      Restore the green flag icon to Subtopic B again. With Power Markers in Auto mode, 

try removing the green flag icon on Subtopic A (the parent of Subtopic B). As soon as 

you remove it, Power Markers restores it again. It ensures that the automatically 
placed markers are always valid. 
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8.      When we configured Power Markers for the Flags group, we chose ""Roll up highest 

marker". This means that Power Markers will roll up the marker that is in the highest 

position in the Flags marker group, starting at the top. 

 

9.      Let's change to a different flag and see this prioritization in action. With Power Markers 

in Auto mode, add another subtopic under Subtopic A, and apply the yellow flag icon 
to it: 

 

10.   Subtopic A and the Main Topic still show the green flag icon, because the green flag 

has a higher ranking than the yellow flag in the Markers group. It can be regarded as 

"more important", and takes priority when rolling up the markers from this group. Now 
right-click on the green flag on Subtopic B, and change it to a blue flag: 

 

11.   You will see that Power Markers now rolls up the yellow flag to the main topic, instead 

of the green flag. With the deletion of the green flag, the yellow flag has become the 

highest ranking marker, and gets rolled up to the parent topics. You can use this 

feature to visualize the "best" or "worst" status within a map, so that you can see the 
areas of a map that need attention without having to drill down into each section. 

You can use the Roll-up feature to keep dashboard maps up to date, where important 

actions and status summaries are visible at the "executive" level, with the navigation 

route to areas of interest clearly identified. Here are some ideas: 

 Roll up action items, so that you can see whether the map contains unfinished 

actions 
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 Roll up priorities, so that you can see whether the map contains high priority items 

 Roll up "worst case" markers, such as green/amber/red color markers, so that you 

can see the current state of health of a project 

 Print out executive summary maps with rolled up markers, so that executives can 

get a quick overview of a subject without exploring the whole map 

Read more about working with the Roll-up feature here. 
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Using Automatic markers 

Mindjet Power Markers provides insight into the information in your maps that is coded 

with Markers. 

But what about other important information, that does not have explicit markers 

associated with it? For example, generating a list of actions that are due within the next 

week would be useful. 

You could generate this list by reviewing your actions each week, and adding a marker to 

the tasks that are due in the next week. Power Markers could then keep track of these 

tasks in the Hot Lists for you. But this would require extra work, and it would not be a 

reliable system. 

Power Markers has another way to solve this - Automatic Markers. An automatic marker is 

a marker (an icon, a fill color or any of the other types of marker) that is automatically 

applied only if a condition exists on a topic. If the condition does not exist, the marker is 

removed. 

The easiest way to use Automatic markers is to use the pre-configured templates, but 

these might not always be exactly what you need. Use the following example to see how 

Automatic Markers work. 

Example: configure an Automatic Marker 

1.      Start a new, empty map. 

2.      In the Map Parts task pane, select the section Power Markers. From the lower pane, 

drag the Map Part "Active Legends" into the map and drop it on the central topic. 

Power Markers will build a set of Active Legend topics reflecting the current marker set 
in the map. We can then modify these to use an Automatic Marker. 

 
Active Legend from the default New map 

Your map may look a bit different if you have modified the markers in your default New 

Map template. (If you already have Active Legends in your map, you won't need this 

step). 

3.      We will use the Font Color of a topic to show us whether it has a due date in the next 

few days. Right-click on the Power Markers icon on the "Font Colors" topic to 
show the map part menu. 
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4.      Click Edit Active Legend settings, so that we can change the way that Power 
Markers deals with the Font Colors marker group. 

5.      Click Behavior to change the way that Power Markers works with this group. 

 
Changing the behavior for this group 

6.      Select Track in Hot Lists only in the Behavior list, and then click OK. 

7.      Now we can add a marker (a font color) to reflect a specific topic condition. Add a 

subtopic to the Font Colors active legend topic, "Due in 7 days", and color the text pink 
using the Font Color tool on the MindManager Home tab. 

 
Defining a pink font color and marker name 

8.      We have defined a pink font color, and the marker name associated with it. But how 

will Power Markers know to use this marker if the topic has a due date within 7 days? 

This is done by adding a $ character and some special text after the marker name. 
Change the topic text from "Due in 7 days" to "Due in 7 days $duedate:7:day" : 

 
Automatic Marker condition added to the marker name 

This means that the marker (a pink font color in this example) will be added if the topic 

has a due date that is due any time between now and the next 7 days. This marker will 

give you an early warning of upcoming due dates. 

9.      We now need to tell Power Markers to update the marker set for this map with this 

new behavior. Click the green Refresh button   on the Active Legend topic, and then 

click OK to update the markers. 

Note: The change we have made will work only in this map, and will not appear in other maps 
unless you configure a new font color marker in the same way. 
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10.   We can test the Automatic marker we just configured. Make sure that Power Markers 

is in Auto mode, so that it responds immediately to changes that you make in the 

map. Click Auto in the Power Markers group on the MindManager Ribbon or in the Hot 
Lists task pane. 

11.   Add a topic to your map, and in the Task Info task pane, set the due date for this topic 

to be the day after tomorrow. As soon as you do this, Power Markers turns the topic 
text pink: 

12.   Change the due date to eight days from now. Power Marker removes the automatic 

marker (pink font), because the due date is more than 7 days away, and the text 

returns to its default color. The same would apply if the due date were set to 

yesterday or before. 

13.   We can verify the marker behavior in the Hot Lists. Return the due date to something 

between now and 7 days time (so the text turns pink), and view the Hot Lists. Your 
topic should be showing in the "Font Colors" group, under "Due in 7 days": 

Note that the automatic marker condition ("$duedate:7:day") is not shown in the Hot 

Lists for clarity - only the text up to the $ character is shown as the marker name. 

This example includes all the steps you would use to set up some of your own Automatic 

Markers. In actual use: 

a. You would rename the "Font Colors" group to be something more meaningful, such as 

"Upcoming tasks". You can do this by editing the Font Colors active legend topic again 

and clicking the refresh button on the active legend. 

b. Just working with the due date alone might not be enough - if you are keeping track of 

tasks, then this would continue to show this topic even when the task had been 

complete. Fortunately, there is a complete set of Automatic Marker conditions that 

cover tasks (with a progress value) in combination with dates, so that you can focus on 

the topics that need your attention in the map. 

Automatic Markers notes: 

So, if you wanted a topic to appear in the "Due in 7 days" list in the Hot Lists, is it 

necessary to always set the due date to make this happen? No. You can color a topic pink 

using the Font Color button Ribbon, and the topic will also show up in the Hot Lists in the 

"Due in 7 days" category. But, if you disable Power Markers, only the marker that was 

applied automatically (based on the Due Date) is removed. The marker you applied 

manually remains in the map. 

Automatic marker conditions can be used for any type of marker, with one restriction: an 

automatic marker condition cannot be used to change itself. For example, an automatic 

marker test that uses the progress value of the task cannot be used to change the 

progress marker on the topic. 

MindManager imposes a 40-character limit on the length of a marker name, and automatic 

marker definitions must obey this limit. Every condition keyword has a unique two-

character abbreviation, so that you can use in the marker definition. If a marker name 

exceeds 40 characters, Power Markers will display an error message when the Active 

Legends are refreshed. The Automatic Marker definition tables list all the available 

automatic marker definitions and their abbreviations. 

All the Auto Markers conditions are configured to display Tags / Text markers. These are 

useful because you can switch off their display in the map (in the View tab > Show/Hide > 
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Tags or Text Markers). They can then be used to collect topics together in the Hot Lists 

without adding to visual clutter in the map itself. Of course, you can change the marker 

type to anything else, if you prefer to see a visual icon or a color. 

Use Auto Markers map parts 

Power Markers also includes a complete set of Map Parts that have all the Automatic 

Marker conditions in them. You can add these to a map, and then customize them by 

deleting or renaming markers. When you refresh the Active Legend topic the marker set 

for the map is updated. 

Example: Use the Due Date map part 

1.      Start a new map, open the Map Parts task pane and in the Mindjet Power Markers 
group, click Auto Markers. 

2.      Drag the "Due Date" map part into your map: 

 
Automatic Marker conditions for the Due Date 

This part, like all the Auto Markers Map Parts, provides markers configured for a wide 

range of conditions so that you can delete the markers that you do not need. 
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Using Active Legends 

Mindjet Power Markers offers a new way to define markers in MindManager by using the 

Active Legend map part. 

Normally, you define the markers list for the map in the Markers task pane and then 

display the markers and their meanings in a legend on the map. Power Markers allows you 

to define markers in an Active Legend map part, right on the map, then update the map's 

markers list so that they are displayed in the Markers task pane. You can add, remove, or 

edit markers and marker groups, and change the marker group behavior from the Active 

Legend map part. 

Using the Active Legend map part to define markers has the following advantages: 

 The definition and explanation of markers can be richer. 

  The Active Legend topics themselves become an information resource in the map. 

Power Markers can create pointers to the Active Legend topics in the Hot Lists, 

making it easy to find important reference information in your map. 

 It is easy to copy Active Legend topics from one map to another to transfer marker 

definitions, and to assemble a set of markers from different sources. 

 You can save marker definitions as Map Parts and build up a library of handy 

markers. This can range from a single group up to complete sets. Power Markers 

installs several sets for you to use and experiment with. 

 The definitions of markers can be distributed throughout the map, and can be 

created without swithching focus to the Markers task pane. For example, you can 

define people where needed in the map, and Power Markers will combine the 

definitions to create a single marker group from there names. 

 It is easy to sort the order of markers in a group when they are displayed as map 

topics. 

 The Active Legend also includes the Resource markers used in a map. 

 It is compatible with all the existing ways to work with markers, and does not 

preclude any of them. The Active Legend topics can be regenerated at any time. 

This tutorial shows you how to configure the markers for a map using the Active Legend 

map part. 

We'll begin by using the Active Legend map part to view and update the list of markers 

used in the current map. 

1.      Start a new blank map. Every new map begins with a built-in marker set which comes 

from the new blank map template. The Markers task pane displays these built-in 

markers. 

2.      To see these markers in an Active Legend, in the Map Parts task pane click on Mindjet 

Power Markers. You will see the Active Legends map part in the lower section of 
the pane: 

3.      Drag this map part into the map and attach it to the central topic. It will refresh itself 

to display a topic for each marker group in the current map. When you expand these, 
you'll see that each marker group topic contains subtopics for all of its markers. 
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4.      Click on the green arrow  on any group name topic to see the Power Marker settings 
for the group. 

 
Displaying the Power Marker settings for a marker group in an Active Legend 

5.      Change the text of the "Happy" marker to "Very happy": 

 
Changing the name of a marker 

6.      To update the map's marker list with the changes you make to an Active Legend topic 

or its marker subtopics, do any of the following: 

 Select the marker group name topic and then press F5. 

 Click the green "refresh" arrows   on the Active Legend topic. 

 Right-click on the Active Legend map part icon and then click Rebuild Map 

Markers in the shortcut menu. 

7.      Power Markers will prompt you for permission to update the marker set. When you 
click OK, it will tell you how many groups and markers it has updated. 

8.      Open the Markers task pane, and you'll see that the marker name change has been 
implemented. 

 

9.      You can use exactly the same process to change the name of a marker group, by 
editing the text of the Active Legend topic and refreshing the map part. 

10.   To change the Power Markers settings of a marker group, either double-click on the 

settings grid in the Active Legend topic, or right-click on the Map Part icon and click 
Edit Active Legend settings in the shortcut menu. You can change the: 

Mutually Exclusive setting - controls whether more than one marker from this group 

can be used on a topic. 

Behavior setting - controls how Power Markers treats the markers in this group 

None 

Power Markers does not process this group. The marker group behaves like a regular 

marker group. 
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Track in Hot Lists only 

Power Markers displays this marker group in the Hot Lists. Topics that possess this 

marker will be displayed in the Hot Lists, and you can toggle the marker on topics 

from the Hot Lists. 

Roll up highest marker 

Power Markers will roll up the highest used marker from this group to the centre of 

the map. So "Neutral" would take higher priority than "Sad". You can easily change 

the priority of markers by rearranging the topics, and refreshing the Active Legend. 

This will show you the "best case" in your dashboard maps. 

Roll up lowest marker 

Power Markers will roll up the lowest used marker from this group to the centre of 

the map. In this example, "Furious" would take priority over "Sad". This would show 

you the "worst case" in your dashboard maps. A typical application of this would be 

to highlight overdue actions in red, taking priority over any other status. 

Roll up combined markers 

Power Markers will roll up all the markers in this group towards the centre of the 

map. This only applies to marker groups that are not mutually exclusive. If you 

assign invalid settings to an Active Legend, Power Markers will correct the settings 

on the Active Legend topic the next time you refresh it. 

11.   You can add and remove individual markers from the map's marker list using the 

Active Legend topic. 

 To delete a marker from the markers list, delete its subtopic under the marker 

group topic in the Active Legend, and then refresh the Active Legend. You'll see that 

the marker has been removed in the Markers task pane. 

 To add a new icon marker to the group, create a new subtopic, name it, assign an 

icon from the Library task pane then refresh the Active Legend. 

12.   We can also use the Active Legends feature to create a new marker group in the map. 

Suppose we want to keep track of the status of items in a specification, so that we can 

see all the essential requirements together in the Hot Lists. Begin by adding a new 
topic to the map, and naming it "Requirement status". 

13.   Now right-click on this topic, and then click Convert to Active Legend in the shortcut 
menu. The topic will be converted to an Active Legend topic: 

 

14.   Next: 

 Leave Group Type set to Text Markers (called "Tags" in MindManager 9). 

 Change the Mutually Exclusive setting to True, because each item in our 

specification document will only have one of these conditions at a time. 
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 Add subtopics to the Active Legend topic to create each of the markers in this 

group: Essential, Optional, Would be nice, Probably never. The subtopic texts 

will be the marker names. 

 Change the Behavior to Track in Hot Lists so that Power Markers will show this 

group in the Hot Lists. (Usually, if a marker group is not appearing in the Hot Lists 

this behavior is not set properly.) 

 

15.   Click the Refresh icon   or select the Active Legend topic and press F5 to update the 

Markers list for the map with the new group. 

 

To use these markers in a different map, you can copy the Active Legend topic to that 

map. Or, to make these markers available in any map, you can save the Active Legend 

topic as a Map Part and then add it to any map you choose. 

See Active Legend marker definitions for more information on how marker definitions are 

represented in an Active legend topic. 

Learn more: 

The topic Advanced Active Legends, gives some more detail: 

 Deleting marker groups 

 Controlling whether marker legend topics appear in the Hot Lists 

 Using the Active Legend Map Parts 

 Combining Active Legends across the map 
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Advanced Active Legends 

This section describes some of the advanced features of Active Legends. You should be 

comfortable with the preceding section on Using Active Legends before reading this one. 

Deleting Marker Groups 

You can use Active Legends to remove entire Marker groups from the map marker set.  

Example: 

1.      Start a new map, and add the Active Legends map part to create a set of Active 

Legends for the default marker set.  

2.      Then delete the "Smileys" Active Legend topics, and refresh one of the other Active 

Legends. Power Markers will ask you for permission to remove the Smileys group. 

3.      If you click Yes, Power Markers will remove the group from the marker set. You can 

select whether Power Markers always removes undefined marker groups, never 

removes undefined marker groups or always asks you for permission in the Power 
Markers Options. 

There are some special rules associated with the removal of marker groups: 

 Some marker groups are mandatory and cannot be removed. You cannot completely remove the 
Priority, Progress, Resources, Single Icons, Fill Colors and Font Colors marker groups. If you 
delete their Active Legends and refresh, then Power Markers will remove the markers from these 
groups, but the groups themselves will remain in the Marker task pane. 

 Power Markers will also ask for confirmation when changing the marker type of an existing group 
- it will treat this as removal of the existing group followed by the addition of a different one. 

 If you want to remove a marker group without losing the marker definitions in the map, change 
the Active Legend topic back to a regular topic. This causes Power Markers to remove the marker 
group, but you get to keep the marker definitions in the map, in case you need them again later. 
To change a topic from an Active Legend back to a regular topic, right-click on the Active Marker 
icon, and select Remove Active Legend settings in the shortcut menu. Tip: keep useful marker 
groups as Map Parts, for easy deployment in other maps. 

 You can't remove the very last marker group using Active Legends, because there is nothing left 
to refresh in the map. If you really need to remove every single marker and group from your map, 
use the Markers task pane. 

Displaying the legend for a marker in the Hot Lists 

Having defined your markers in the Active Legends topic, how do you find the definitions 

when you need them? The Power Markers Hot Lists are the obvious place to look. But how 

does Power Markers know the difference between a topic that defines a marker in an 

Active Legend topic, and a normal map topic that just uses this marker? 

The Configuration dialog contains an option for ignoring legend topics that define markers. 

When this is checked (the default), any subtopic of an Active Legend topic that defines a 

marker is excluded from the Hot Lists. When it is unchecked, the Hot Lists include all topics 

that define the markers, as well as the topics that use them. 

If you want to display only some of the legend topics, you can enbale the configuration 

option to ignore legend topics, and then code individual legend topics to override this 

setting. Simply add a # character at the start of their definitions. Legend topics that begin 
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with # are always shown in the Hot Lists, regardless of the setting in the configuration 

dialog. 

Try this example: 

1.      Start a new map, and add the Active Legends map part to create Active Legends for 
the default marker set. 

2.      Open the Hot Lists pane, and then click Auto. The Hot Lists pane is empty because the 
map contains only legend topics, and the configuration option is set to ignore them. 

3.      Click the Power Markers Configure button (either in the MindManager Ribbon or the 

Hot Lists), un-check the option Ignore legend topics that define markers, and 
then click Save. 

4.      You will see that all the topics that define markers in the Active Legends are now 

shown in the Hot Lists. 

5.      Click the Configure button and re-enable the option to ignore legend topics, and click 

Save. 

6.      The Hot Lists will be empty again, as all the legend topics are ignored. 

7.      To override this setting for a specific legend topic change its text so that it starts with 

a # character. 

Note that the definition you choose to display must belong to a group whose behavior 

is not set to None. 
For example: 

 
Forcing a legend topic to appear by prefixing it with a # character 

8.      The legend topic for the "Not done" marker will now appear in the Hot Lists: 

 
A legend topic in the Hot Lists 

The # character does two things: it reminds you that this is the definition of the "Task 

start" status, and it also conveniently sorts this topic to the start of the list in the Hot 

Lists, above all other topics that have this marker. You can click on this item in the Hot 
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Lists to go to the definition of the marker, as opposed to visiting an instance of the 

marker being used on a topic. 

If you used this technique on a Resource marker that represented a person, you could 

keep their contact details in the legend topic, and find them quickly just by clicking on the 

#-item under their name in the Hot Lists. So for certain types of information in your map, 

you can define it once in an easily-found place, and do not need to duplicate it again 

elsewhere. 

Using the Power Markers Map Parts 

Power Markers adds a set of Map Parts to MindManager that include marker definitions for 

a wide range of uses. Of course, this set of Map Parts does not cover every possible 

situation, and you can always create your own custom Active Legends and marker 

definitions at any time. But the Map Parts will give you a head start. 

The Map Parts are divided into seven folders: 

The Mindjet Power Markers map part folder contains the Active Legends map part (that 

imports the existing marker set) and an empty Active Legend topic that can be used as 

the starting point for a new Active Legend. It also contains the other six folders below. 

The Auto Markers folder contains map parts that give examples of the Automatic Marker 

conditions. The contents of each map part, and the definition of the Automatic Marker 

conditions are listed under Automatic Marker definitions. The sample Active Legends for 

Auto Markers mostly define them asText Labels. The Text Label markers are unique in that 

their display in the map can be suppressed with the View>Show/Hide command in 

MindManager. This makes them especially useful for marking topics where you need to see 

the groupings in the Hot Lists, but do not necessarily need to see the labelling in the map 

itself - in fact, excessive use of visible Text Label markers in the map can be quite 

distracting. So where you are deriving secondary information using automatic markers, 

Text Label markers are a good choice. 

The Color Markers folder contains sample Active Legends for the topic fill color and font 

color markers. 

The Complete Sets folder contains complete sets of Active Legends to implement various 

common types of Dashboard map. 

The Icon Markers folder contains sample Active Legends with some canned icons. These 

icons are taken from the built-in MindManager library. 

The Task Info folder contains sample Active Legends relating to task information on 

topics. This includes progress, priorities, resources and automatic markers that interpret 

date information in the context of unstarted or incomplete tasks. Some of these map parts 

are also listed in the Automatic Marker definitions section. 

The Text Markers folder contains a sample map part showing how to define Text Markers 

/ Tags. 
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Combining Active Legends across the map 

One of the advantages of the Active Legends approach is that you can have multiple 

definitions of the same Marker Group spread across your map. This lets you collect and 

organize information in a way that you can easily find it again. You are not restricted to 

keeping marker definitions in a neat tree in one place. Normal "information" topics in your 

map can also become the definitions of markers, integrating the use of markers and the 

structure of your map. 

Consider the following fragment of a map: 

 
Defining markers within markers, and the same group multiple times 

In this map, we are dealing with a number of organizations, and people in those 

organizations. We need to be able to use markers for either, and we need to be able to 

find people without knowing what organization they belong to. 

The "organizations" Active Legend defines a set of Text Label markers, of which there are 

three (Acme, Widgets and Foobar). Each of these organizations has some people 

associated with it. These are defined under a "People" Active legend for each. The "People" 

Active Legend is a Resources marker type. Since there can only be one Resources marker 

group, what Power Markers does in this case is merge together all the resource markers 

defined across the map, and sort them alphabetically. So Power Markers sees the following 

in the Hot Lists: 

 
Merged markers in the Hot Lists 

It has done this by combining all the marker definitions that relate to the same marker 

group. It matches marker groups on type, and on name if they are not a unique type. You 

can organize the information in your map in a navigable hierarchy, and Power Markers will 

merge similar items together in the Hot Lists. 

But what happens if you have three, five or ten instances of a the same group defined by 

Active Legend topics, and you want to change the mutual exclusivity flag or the behavior 

of the group? When you refresh an Active Legend topic, all the Active Legends in the map 
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get refreshed, but the one that is selected when you launch the refresh takes priority over 

any other definitions of the same group. So in the above example, if you changed the 

behavior of the "People" Active Legend under "Acme" then refreshed that specific Active 

Legend, the other two (under Widgets and Foobar) would be updated to match. As a rule 

of thumb, it is worth always initiating the refresh of Active Legend topics from the one that 

you just edited, to ensure that any changes get copied to other instances of the same 

marker group. 
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Using the template dashboards 

Using the dashboard templates 

Mindjet Power Markers includes a set of map template dashboards, so that you can get 

started with an already working design, or use them as the starting point for custom 

dashboard maps. 

The following Templates are installed with Mindjet Power Markers: 

 The Power Markers Demo 1 template to help you see Power Markers at work on a 

map. 

 The Generic Dashboard templates to track projects or situations. 

 The Meeting Dashboard template to track meeting agenda items and action items 

by participant. 

 The GTD Dashboard templates to use GTD principles to keep track of a specific area 

or project. 

Start a new map from a Power Markers template 

1.      Navigate to the Template chooser in MindManager: 

 In MindManager Version 8, click the MindManager button, and then click New - 

From Templates or Style. 

 In MindManager Version 9, click the File tab, and then click New. 

2.      Scroll the backstage view or preview  until you see the Mindjet Power Markers 
dashboards. 
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The Power Markers dashboard templates in the template preview dialog 

3.      Double-click on the template that you want to use, and a new map based on the 

template will be opened. 

Use the template 

Begin by reading the Topic Notes of the central topic. The Power Markers dashboard 

templates use Power Markers to help you get the template set up. The steps are the same 

for every template: 

1.      Open the Hot Lists task pane. 

2.      Make sure Power Markers is in Auto mode. 

3.      Open the "Assets" list in the Hot Lists (this might be called something else in some 

dashboards, but the Central Topic notes will give the exact name) 

4.      Open the "Template Tour" list 

5.      Visit the Template Tour topics and review the Topic Notes to get the template 
configured. 

6.      You can delete the Template Tour topics when you have completed each step of the 
configuration, as you will not need them again. 

As an example, here are the Template Tour topics for the Standard Generic Dashboard 

template: 

 
Template Tour topics in a dashboard template 

Map Parts 

The dashboard templates are also included as Map Parts, consisting of the Active Legend 

topics that make up the marker set, so that you can implant the dashboard functionality 

into an existing map. We recommend that you familiarize yourself with the principles using 
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a template first, before starting to reconstruct an existing map. The Map Part versions do 

not include the "Template Tour" markers and have less documentation built into them. 

To access the Map Parts, open the Map Parts task pane open the group Mindjet Power 

Markers > Complete Sets. You can drag a map part into any map and it will expand to 

create the Active Legend topics. 

  

The Generic Dashboard templates 

The Generic Dashboard templates are designed to help you to keep track of small projects 

or ongoing situations, by creating lists of items from your map. They do not follow any 

specific methodology, and you can customize them to meet your exact needs. There are 

two versions: the Standard Generic Dashboard and the Enhanced Generic Dashboard. 

Template Features 
Standard 
Generic Dashboard 

Enhanced 
Generic Dashboard 

Template Tour 

Set up your dashboard from 
the template 

Yes Yes 

Actions 

Keep track of incomplete 
actions 

New tasks 

Tasks in progress 

Completed tasks 

New tasks 

Tasks in progress 

Completed tasks 

Action Deadlines 

Get a visual indicator of things 
that are late or coming up soon 

  

Overdue - tasks that are not far enough 
forward to make their deadlines, or are late 
starting 

In next 3 days - things that should be 
started or finished in the next 3 days 

In next 4 weeks - things that should be 
started or finished within 4 weeks 

Map Assets 

Keep track of vital information 
stored in your map 

Questions 

Issues 

Attachments 

Email addresses 

Hyperlinks 

Web links 

Email addresses 

Attachments 

Linked files 

Linked folders 

Multi-maps 

Mindjet Catalyst links 

Built-in SWOT analysis 

Keep track of the positives and 
negatives about your project or 
situation 

  

Strengths 

Weaknesses 

Opportunities 

Threats 
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The Meeting Dashboard template 

The Meeting Dashboard is designed to help you to keep track of ongoing meetings. You 

can use it to prepare for a meeting, to keep track of the agenda and actions during a 

meeting, to wrap up at the end of the meeting, and to review ongoing actions items again 

at the start of the next meeting. 

Template Features Details 

Template Tour 

Set up your dashboard from the template 
Yes 

Actions 

Keep track of ongoing actions 

Open action items 

Actions held over 

Completed actions 

Meeting Materials 

Keep the information you will need during meetings only one click away 

Attachments 

Hyperlinks 

Meeting Agenda 

Mark up the topics in your map for use during the meeting, to ensure that 
you cover everything even if the discussions move around a lot 
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The GTD Dashboard Templates 

The GTD Dashboard templates are demonstrations of how Mindjet Power Markers can be 

used to implement a well-defined process or method. 

The core concept behind "Getting Things Done" is to collect information, then sort it into 

lists that help you to focus on what action to take in certain situations. An implementation 

of this in Power Markers means using markers to code information across your map, and 

letting the Hot Lists do the list-making. You can visually organize your map by subject or 

small project, and the Hot Lists keep everything sorted into lists. The Power Markers 

demonstration map is based on the GTD templates. 

These lists extend to GTD Review cycles. The Reviews list in the Hot Lists summarizes 

topics to check when going through your short, medium or long term reviews. 

Mindjet Power Markers adds two GTD dashboard templates to MindManager: the Standard 

GTD Dashboard and the Enhanced GTD Dashboard. 

Template Features 
Standard GTD 
Dashboard 

Enhanced GTD Dashboard 

Template Tour 

Set up your dashboard from the 
template 

Yes Yes 

Next Actions 

Keep track of next actions across 
your projects 

Unstarted 

Unfinished 

Completed 

Unstarted 

Unfinished 

Completed 

Daily Lists 

Refer to the Daily Lists in the Hot 
Lists to keep an eye on actions by 
context. The contexts are 
automatically detected from the topic 
text; e.g. typing "Call Juan" will 
automatically assign the @Calls 
context. Refer to the documentation 
in the template map for more details. 

Waiting-for items - 
things owed to you 

@Agendas context 

@Calls context 

@Errands context 

In-basket items - things that need to be 
sorted 

Waiting-for items - things owed to you 

@Office context 

@Home context 

@Calls context 

@Read/Review context 

@Computer context 

@Errands context 

@Expenses claim context 

Deadlines 

Get a visual indicator of things that 
are late or coming up soon 

  

Overdue - tasks that are not far enough 
forward to make their deadlines, or are 
late starting 

In next 3 days - things that should be 
started or finished in the next 3 days 

In next 4 weeks - things that should be 
started or finished within 4 weeks 
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Project Reviews 

The Hot Lists support the review 
processes by grouping together 
things for review 

Runway-level 
projects 

Someday/Maybe 
items: review items 
that are deferred 
indefinitely 

Runway-level projects - immediate work 

10,000 ft projects - operational projects 

20,000 ft projects - areas of responsibility 

30,000 ft projects - 1 to 2 year goals 

40,000 ft projects - 3 to 5 year plan 

50,000 ft projects - Life plan 

Tickler / next year: review tickler file items 
while they are still a long way out 

Tickler / future: review tickler file items that 
are in the distant future 

Someday/Maybe items: review items that 
are deferred indefinitely 

Tickler file 

Track dates items and have them 
appear in the Hot Lists when due for 
attention or when coming up on the 
horizon 

  

Today 

This week 

Next week 

This month 

Next month 

Historical (date passed) 

Future (beyond next month) 

Support Materials 

Keep track of resources that support 
your projects 

GTD Reference links 
and information, 
including review 
summaries 

GTD Reference links and information, 
including review summaries 

Multi-map links 

Web links 

E-mail addresses 

Attachments 

Linked files 

Clean-up Review 

Clean up items in your map to make 
sure that they are being tracked 
properly 

  

Partly defined actions: topics that have 
some task information but which are not 
marked as actions 

Actions without dates: topics marked for 
action which do not have a start or due 
date so will not appear in the tickler file or 
the deadlines section 

Also available as a Map Part 
Refer to the Map Parts task pane > 
Power Markers > Complete sets 

Yes Yes 

Disclaimer: the GTD dashboard templates are not officially endorsed implementations of 

GTD and are included only as a demonstration of the capabilities of Mindjet Power Markers. 

"GTD" and "Getting Things Done" are trademarks of the David Allen Company. 
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Using existing maps 

To use Mindjet Power Markers with your existing maps, you may need to ensure that all 

the markers you use are named markers. If markers called "Marker Name" appear in the 

Hot Lists, then it is likely that they are unnamed in the Marker List. You can use the 

Markers list commands to name these markers, or use the Power Markers Configuration 

dialog function to name them more quickly. 

What is an "orphan" Marker? 

Orphan markers show in the Markers list as unnamed markers. 

These "orphan" markers can be introduced on the map in a number of ways, including: 

 A previously unused topic text or fill color might be selected on the Ribbon 

 A custom icon might be added directly from the library 

 A previously unused Priority or Progress value might be entered in the Task Info 

pane, written by other software, or imported on a topic from another map 

 A marker was deleted in the Marker List, but it is still used in the map 

Turn orphan Markers into Power Markers 

For this example, we'll create some orphan markers, and then name them so they can be 

used as Power markers. 

1.      Start a new blank map. 

2.      Add a topic and select it. 

3.      In the Library task pane, select a custom icon that does not exist in the current Marker 
List (from a sub-folder such as one of the Alpha custom icons). 

4.      Use the Ribbon commands to apply a green fill color and red font color to the topic. 

 

5.      In the Markers task pane you'll see a new Marker group called "General Icons" 

containing the icon you added, the green fill color marker in the Fill Colors group, and 

the red text in the Font Colors group. Each of these markers displays its name as 

"Marker name" in gray text. 

If you remove the last instance of one of these unnamed markers from the map, it is 

also removed from the Markers pane. Although these unnamed or orphan markers can 

be used from the Markers List, they are not available as Power Markers until they are 
named. 
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6.      Click Configure and then click Import orphan Map Markers in the Power Markers 

Configuration dialog. Power Markers will scan your map and prompt you for a name for 
each unnamed marker it finds. 

 

OK imports this marker and continues 

Skip Marker does not import this marker, and continues 

Skip Group does not import this marker or any others in this group, and continues 

Cancel will not import this or any other markers. 

This function can not be used to rename custom icons in the General icons group (icons 

added from a Library group other than the MindManager group). If unnamed custom 

icons are found on your map you will need to enter names for these in the Markers 

pane. As soon as a General Icon is named, it automatically moves to the Single Icons 

group. 

7.      When all marker have been reviewed and imported, Power Markers updates the 

Configuration settings. Check the Configuration dialog to see that you have set the 
group behaviors appropriately for all the marker groups. 

The markers will now show their proper names in the Hot Lists. 
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Compatibility issues 

There are occasions where Mindjet Power Markers may conflict with other Add-ins and 

MindManager features. Power Markers will try to pre-empt situations where a conflict might 

occur, and display warning messages so that you can choose how to continue. You can 

disable the display of Compatibility warnings in the Options window, or by disabling this 

option in the warning dialog. 

Compatibility with Task Management features 

The Task Management features in the MindManager Task Info pane are provided by the 

Project Task Management (PTM) add-in shipped with MindManager. These features can 

conflict with the roll-up of progress markers in Power Markers, as both are doing 

essentially the same job. If both are enabled at the same time, Power Markers will raise 

warning messages when it tries to overwrite the markers automatically placed by the PTM 

add-in, but it will not overwrite these markers. 

If the progress marker is configured for roll-up in Power Markers, you will a compatibility 

warning message when Power Markers is enabled. 

You will not be able to use both Power Markers and the Task Management feature in 

MindManager to roll up the progress markers. By default, the Task Management feature 

roll-up takes precedence - Power Markers will not change markers added by this feature. 

You can choose which method will be appropriate for your needs: 

Project Task Management add-in Power Markers roll-up feature 

Rolls up Progress values 

Rolls up task Durations 

Uses protected Progress icons 

Rolls up any marker including task Progress & Resources 

Does not roll up task Durations 

Uses standard markers 

Can also roll up ranked markers for best/worst analysis 

And then use that method: 

Use the Project Task Management 
add-in 

Use Power Markers 

Do not enable roll-up of the progress 
marker group in the Power Markers 
configuration 

Do not use the Task Management roll-up feature, or 

Disable the PTM Add-in MindManager Options > Add-ins 
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Mindjet Power Markers Options 

Power Markers has its own set of options that apply to all maps. To access these: 

 In MindManager 9 click the File tab, click Options, and then click Mindjet Power 

Markers. 

 In MindManager 8, click the MindManager button, click MindManager Options, 

and then click Mindjet Power Markers. 

You can change the following options: 

Show splash screen on start-up controls whether the Mindjet Power Markers splash 

screen is displayed when MindManager starts up. 

Warn me before overwriting my Map Markers controls whether Power Markers issues 

a warning before replacing any of your Markers in a map. When using the roll-up feature, 

Power Markers may need to replace or remove a marker that exists in the map where it 

needs to place its own. 

Warn me about compatibility issues will display warning dialogs if your Power Markers 

configuration or settings might conflict with other Add-ins or MindManager settings. These 

are described here. 

Focus on topic when selecting it from the Hot Lists controls whether Power Markers 

uses the "Focus" command (F3), which centres the selected topic, expands its subtopics, 

collapses other topics, and increases the zoom level if there is space to do so. If this option 

is not checked, then the topic is selected on the map, and scrolled into view. 

Show tool tip texts on buttons and checkboxes can be disabled when you are 

comfortable with the Power Markers commands. Changes to this option only take effect the 

next time you start MindManager. 

The Financial Year option allows you to specify the dates for your financial calendar. The 

commonly used dates from around the world are listed. If you need some special dates 

here, please contact us and we can show you how to modify them. The Financial Year 

information is used by some of the automatic markers. 

The Power Markers ribbon shortcut keys can be enabled or disabled. These are the 

shortcut keys that are visible when you press the Alt button in MindManager, for example 

Alt+H for the Home tab. It is possible that MindManager add-ins from different vendors 

could have the same shortcut keys, or the shortcut keys could clash with those already 

used in MindManager. If you experience any problems with the Power Markers shortcut 

keys, then you can disable them in the Options. 

When refreshing Active Legends... lets you specify what action Power Markers should 

take when it needs to delete undefined Marker Groups when refreshing Active Legends. If 

you always answer either Yes or No to the prompt to delete undefined Marker Groups, then 

you can bypass the prompt by setting this option. 

Note that other settings, such as the behavior of the Power Markers in an individual map, 

are edited and stored per-map using the Configuration settings. 
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How to... 

Track follow-up actions from a meeting 

Power Markers can help you to keep track of action items in a meeting, if you use 

MindManager to capture the meeting. 

You can add Resources to your map in real time. There are several ways to assign a 

Resource to a topic: 

1.      If the Resources are already entered into the Marker List, open the Markers task pane, 

select the topic in the map, and select the Resource from the list in the Marker task 
pane. 

2.      Select the topic in the map and type a name into the Resources box in the Task Info 
pane. 

3.      If the Resources are already named in the Marker List, in the Hot Lists task pane, 

enable Power Markers, enable Edit Power Markers on topics, select a topic in the map 

and click on the Resource name in the Hot Lists. 

You can show or hide the resource names by controlling the display of Task Info, either 

in the Task Info task pane or from the Ribbon's View tab. 

The Power Markers Hot Lists pane shows the topics in the map, organized by the 

person responsible: 

 

It is useful to keep the Hot Lists in view as the meeting progresses, so that participants 

can see their responsibilities developing, and the meeting wrap-up automatically 

includes a summary of who is doing what. 

It also becomes obvious if anyone has either too much or too little to do. In the above 

example, Asha might consider asking Peter to help her with some of her tasks. If you 

add more than one resource name to the same topic, then the topic appears under 

more than one name in the Hot Lists: 
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To follow up after the meeting, in the Hot Lists task pane click Copy Hot Lists to 

Clipboard, then paste the text into an e-mail or document that summarizes everyone's 

actions. 

 

At the next meeting, you can begin by reviewing progress against actions from the 

previous meeting, working from the same map. 
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Create a SWOT analysis 

Just about every implementation of a SWOT (Strengths, Weaknesses, Opportunities and 

Threats) Analysis in MindManager is based on starting with a small analysis tree: 

 

Individual Strengths, Weaknesses, Opportunities and Threats are listed as sub-topics of 

the headings. The analysis is assumed to relate to the parent of its tree, or might be 

specifically named (e.g. "Competitor SWOT Analysis"). 

While this approach has merits, it also has a disadvantage - the work is constrained to one 

part of the map. Assuming that the analysis is drawn from information across the whole 

map, this grouping means you have to keep moving backwards and forwards between the 

analysis and related information. Sometimes you want something to be marked with a 

SWOT marker, but to be positioned elsewhere in the map. Or you may feel that some if the 

items belong under more than one heading, which is not easy to represent. 

By contrast, the Power Markers Hot Lists let you create a SWOT Analysis in a very different 

way, by treating the whole map as the analysis, and not just one part of it. The map can 

structured in any way you wish, or even remain as a "fast and loose" brainstorm, while 

Power Markers takes care of the list-making. 

Using the Hot Lists for SWOT Analysis 

1.      Click the Markers task pane tab to open the Markers task pane. 

2.      Click the link Add new icon group. 

3.      Name the group " SWOT Analysis * ". Note the asterisk at the end, which tells Power 

Markers to include this group in the Hot Lists. (If you omit the asterisk here, you can 

enable this group in the Hot Lists from the Power Markers Configuration dialog). 

4.      Right-click on the SWOT Analysis group name, and click New Icon Marker. Name the 

marker "Strengths", and choose a suitable icon, such as the thumbs-up icon as shown 
above. Click Add when you are finished, but do not exit the dialog. 

5.      Continue to add icons for Weaknesses, Opportunities and Threats. Your marker group 

in the Marker List should now look similar to the example below, although of course 
you could use any marker style you like. 
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Note that we have used plural names, i.e. "Strengths" rather than "Strength". We will 

see why later. It is also useful to ensure that the markers are listed in the above order, 

for convention more than anything else. 

6.      You are now ready to mark up your map as a SWOT analysis. Simply apply the SWOT 

markers to the relevant topics anywhere in the map, to indicate their contribution to 
the analysis: 

 
This is the kind of work at which MindManager excels. Your map may look different from 

the example above. 

7.      In the Hot Lists task pane and click the Auto button so that Power Markers builds and 
displays the Hot Lists: 
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Now you can see why we called the icons "Strengths" instead of "Strength". Your SWOT 

analysis can be viewed as a group, regardless of where the information lies in the map. 

You can rapidly create a summary of your SWOT analysis in the same map or a 

separate map. At the bottom of the Hot Lists task pane, click the link Copy Hot Lists 

to Clipboard and paste it into the current map or a new map: 
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The summary is created in a few seconds without any additional typing or reorganizing. 

This is especially useful if your map contains lots of other information as well as SWOT 

elements, meaning you don't have to work through the map to extract and copy the 

information that relates to the SWOT analysis. 

You can do even more with the Power Markers approach to a SWOT analysis: an item can 

exist under more than one heading at the same time, which is a realistic situation. In our 

above example, "Longer commute for some" could be regarded as a weakness (because 

longer commutes are tiresome and expensive) and also a future threat (because some key 

people might start looking for another job). Marking it with both markers in the map 

means it should be considered from both viewpoints. To enable this, in the Markers task 

pane right-click the SWOT Analysis * group name. Un-check the Mutually Exclusive 

option. You can now apply more than one SWOT marker to the same topic, and it will 

appear more than once in the Hot Lists. 
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Keep track of favorite topics 

Sometimes it can be handy to access favorite topics in a map and jump straight to those 

locations. You can use the Power Markers Hot Lists to list the favorite topics in your map in 

one place. 

MindManager labels are a convenient way to do this, because you can label a topic 

with Ctrl+Shift+F5, which is quicker than adding a marker. Power Markers can show you 

a list of labeled topics. 

1.      Assuming that you are using Active Legends in your map: 

a. Open the Map Parts task pane 

b. Open the Mindjet Power Markers folder  

c. Open the Auto Markers sub-folder 

d. Drag the map part "Topic Label" into your map 

e. Move the "Topic Labels $label" marker definition topic from this map part into any 

existing Icon group or the Single Icon group in your Active Legends 

f. Delete the remainder of the Topic Label map part, as it is not needed 

g. Refresh your Active Legends. 

2.      If you are not using Active Legends: 

a. Open the Markers task pane 

b. Create a new Icon markers group if there is no suitable group to which you can add 

a "label" icon 

c. Add an asterisk at the end of the target group name to ensure that it appears in the 

Hot Lists 

d. Add an icon to the new icon, an existing Icon group, or the Single Icons group. 

Select an icon from the MindManager icons, and name it "Labels$label" (without the 

quotes). The "$label" text turns this into an Automatic Marker that is activated if a 

topic possesses a topic label. 

e. If Power Markers is in Auto mode, leave and re-enter Auto mode to ensure that it 

reads the new marker set again. 

3.      To mark a topic as a favorite topic, select it and click the Label button on the Insert 
tab on the Ribbon. 

Labeled topics will be shown in the Hot Lists and you can jump straight to them. 

This mechanism provides a convenient way to jump straight to specific locations in a map, 

without adding any more visual markers to the map itself. You can just click on the topic 

text in the Hot Lists to go straight to the topic in the map. Of course, you could navigate 

through the map itself to find the same information, but this depends on having the map 

well enough signposted that you can still navigate it quickly after a few weeks or months of 

not using it - which is not a strong feature of many maps! 
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Use Show Branch Alone mode 

Power Markers can work in conjunction with MindManager's "Show Branch Alone" mode, to 

help you focus on a particular area of your map. 

The "Show Branch Alone" feature lets you view a part of a map without seeing the whole 

map, making a selected topic the temporary "central topic". To use it, select a topic in your 

map, then on the View tab, click Show Branch Alone. To return to the whole map, click 

Show Other Branches. This is standard MindManager functionality. 

Show Branch Alone mode works by filtering out everything except the tree you are 

focusing on. Before using Power Markers in conjunction with Show Branch Alone mode, you 

need to decide whether Power Markers should include filtered-out topics, or whether it 

should only be aware of topics that are currently shown in the map. This is set per-map in 

the Power Markers Configuration dialog. By default, Power Markers will not include filtered-

out topics, so the information it displays will vary depending on whether or not the map is 

filtered. If you want Power Markers to always show information across the whole map, 

including topics that are filtered out, then enable the setting in the Configuration dialog. 

With Power Markers set to ignore filtered-out topics, the Hot Lists contain only the topics in 

the area of focus. Consider the following example from a review meeting map: 

 
The Hot Lists show actions across all projects, grouped by Resource 

The Hot Lists show actions across all the projects, grouped by person. If you want to 

review one project at a time, then all you need to do is select a project, and click the 

Show Branch Alone command on the Ribbon: 
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In Show Branch Alone mode, the Hot Lists show actions from the selected project only 

The Hot Lists now show the actions from the selected project only. 

You can use this feature to focus your attention on the markers from one part of the map. 

For example, you could perform SWOT analyses by business area, within the context of a 

whole-business SWOT, by organizing your SWOT map into business areas. 
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Use Power Markers with Mindjet Catalyst 

Power Markers can be used in real time with Mindjet Catalyst so that other users can also 

see the information that Power Markers creates. Note that this applies to the simultaneous 

sharing of maps in MindManager for Windows, and not to the Web-based mapping 

component of Catalyst (which does not support Add-ins). 

There are two scenarios: 

1.      Single host: one participant has the Power Markers add-in installed, but others do not 

2.      Multiple hosts: more than one participant has the Power Markers add-in installed. 

In the single host scenario, participants who do not have the Power Markers add-in 

installed will see rolled-up markers in their copy of the map, but will not see the Hot Lists 

task pane. Power Markers must be installed locally to view the Hot Lists. If a participant 

who does not have Power Markers installed makes a change to the map that is relevant to 

Power Markers, then their map will be updated when the single host updates their map, or 

when it is automatically updated if Power Markers is in Auto mode. 

Use Power Markers with Catalyst Example: 

1.      Anne and Bill are in a Mindjet Catalyst conference, sharing a map 

2.      Anne has Power Markers installed, has enabled it for the shared map, and has Auto 

mode active 

3.      Bill deletes a topic that carried a Power Marker 

4.      This is replicated on Anne's system, which updates the rest of the tree, which is in 
then reflected on Bill's system. 

There may be a delay of a few seconds between Bill editing the map and seeing the 

changes in his copy. 

In the multiple hosts scenario, there should only be one user who has Power Markers in 

Auto mode, and the rest should have it disabled. If multiple users have Power Markers in 

auto mode, then there will be multiple copies of Power Markers trying to update the map in 

real time, which might produce unreliable results. 
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Reference 

Glossary of terms 

Term Meaning 

Active Legend 
A special topic in a map, recognized only by Power Markers, that defines a marker 
group and the markers that it contains. Active Legends provide an alternate way to 
specify and label the markers in your map. 

Legend topic 
Legend topics in the map describe or define marker groups and markers. A 
"passive" legend can be created from the Markers task pane, or can be an Active 
legend that defines the groups and markers. 

Markers List 

A collection of Marker Groups. Each map has one Markers List associated with it, 
but Markers Lists can also be exported and stored individually. You can create a 
new Markers List from a document, and apply it to other maps, or share it with other 
users. Refer to the MindManager documentation for more information about using 
Markers Lists. 

Marker Group 
A collection of Markers of the same type. Many of the types are only allowed to exist 
once, such as the Progress markers. You can add extra Icon marker groups or Tag / 
Text marker groups. 

Mutually 

Exclusive 

A flag indicating whether more than one marker in a group can exist on a topic at 
the same time. If the marker group is mutually exclusive, then only one of its 
markers can be used on any individual topic. The Priority Marker group is an 
example of this - a topic cannot have more than one Priority at a time. If you click on 
a Priority marker on a topic, it will be replaced by the next one in the group. If a 
marker group is not mutually exclusive, you can use more than one of its markers at 
the same time. The default "Single Icons" marker group can have more than one of 
its icons on a topic. To change the mutually exclusive setting for a marker group, go 
to the Map Marker task pane, right-click on the group name and change the 
"Mutually Exclusive" flag. You can also change the mutually exclusive status in the 
Power Markers Configuration dialog. 

Marker 

A single icon, text color, text label or other mark-up decoration. Each marker has a 
name associated with it so that its meaning is clear in the map. A Marker can 
appear in only one Marker Group, e.g. the same icon cannot belong to more than 
one group at a time. Refer to the MindManager documentation for more information 
about using Markers. 

Automatic Marker 
A feature of Power Markers that associates a real marker with a special condition on 
a topic, such as "incomplete task due within 3 days" or "has a Multi-map link". See 
the complete list of Automatic Marker definitions. 

Progress marker 

A marker that shows how complete a task is, from 0% to 100% complete. This can 
also be edited in the Task Information task pane, and is also linked with many task 
management or project management applications of MindManager. Icons in the 
Progress marker group are always mutually exclusive. 

Priority marker 
A marker that indicates the priority of a topic, typically associated with a task. Icons 
in the Priority marker group are always mutually exclusive. 

Resource marker 

A text-only marker that shows the resource or ownership associated with a task. 
This information can also be edited in the Task Info task pane and is accessed by 
many project management applications of MindManager. Markers in this group are 
never mutually exclusive. 
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Text marker 

(MindManager 

Version 8) 

Tag (MindManager 

Version 9) 

A text-only marker that shows any text-based status for a topic. "Resources" and 
"Categories" are special cases of Text Markers/ Tags. The markers in this group 
can optionally be mutually exclusive. Unlike most of the other markers, they do not 
also have a name, as their text is their name. 

Icon 

A graphic added to the topic to visually convey meaning. These are the original 
"Map Markers", and many people still refer to Icons when talking about Markers. 
You can add extra Icon Marker groups, and choose whether or not they are mutually 
exclusive. 

Single Icons 
A special marker group that must always be present, containing Icon markers. The 
Single Icons group is not allowed to be mutually exclusive. 

Custom Icon 
An icon marker that is created from a graphic file, rather than one of the built-in 
icons included with MindManager. 

Fill color marker 
The fill colors used on topics can be given a name and included in the Markers List. 
Topic fill colors are always mutually exclusive, and there can only be one fill color 
marker group. 

Font color marker 
The text colors used on topics can be given a name and included in the Markers 
List. Topic text colors are always mutually exclusive, and there can only be one text 
color marker group. 

Map Part 
A built-in feature in MindManager that saves a fragment of a map in a common 
location, from where it can be used in other maps. Refer to the MindManager 
documentation for more details. 

Configuration 

The Configuration of a map tells Power Markers how to handle the Markers that the 
map contains. You can choose whether Marker groups are displayed in the Hot 
Lists, rolled up in the map, or ignored by Power Markers. The configuration is 
defined per-map and is stored in the map, so you can have different configurations 
for every map. 

Default 

Configuration 

If Power Markers does not find any configuration information in a map, then it 
reverts to the default configuration. This allows predefined marker groups to be 
regarded as Power Markers, without any explicit configuration of individual maps. 
Any configuration can be saved as the default configuration, so you can set this up 
as required. 

Roll-up 

The Power Markers function that makes copies of Markers on the parent topics up 
to the middle of a map, so that the existence of selected markers can be easily seen 
even when the topics are hidden. The configuration of which markers act as Power 
Markers is edited in the Configuration dialog, and stored in each map. 

Hot Lists 
The Power Markers function that shows a list of topics organized by Marker. The 
Hot Lists are shown in a task pane. The configuration of which markers act as 
Power Markers is edited in the Configuration dialog, and stored in each map. 

Splash dialog 
The Power Markers dialog that appears each time MindManager starts up. It can be 
disabled in the Power Markers Options. 

Options 
Settings for Power Markers that apply to all maps. They are edited in the 
MindManager Options dialog. 

Ribbon Shortcut 

keys 

The Power Markers commands can be accessed with shortcut keys. These are 
displayed in the Ribbon by pressing the Alt key. They can also be disabled if they 
are found to clash with shortcut keys from another add-in or MindManager function. 
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Active Legend marker definitions 

When defining markers in the subtopics of an Active Legend topic, this is how they are 

represented: 

Group type What is in the subtopic for each marker 

Task Priority 
A priority icon to indicate the priority (use the Task Info task pane to assign) 

The topic text is the priority name 

Task Progress 
(%) 

A percent complete icon to indicate the task progress (Use the Task Info task pane 
to assign) 

The topic text is the progress name 

Resources The topic text is the resource name 

Text Markers / 
Tags 

The topic text is the text marker / tag name 

Icons  
A standard (stock) MindManager icon or custom icon 

The topic text is the marker name 

Single Icons 
A standard (stock) MindManager icon or custom icon 

The topic text is the marker name 

Fill Colors 

The fill color used on the topic is the color for the marker. This must be a non-
automatic color. Automatic colors are not regarded as markers. 

The topic text is the marker name 

Font Colors 

The font color used on the topic is the color for the marker. This must be a non-
automatic color. Automatic colors are not regarded as markers. 

The topic text is the marker name 
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Automatic Marker definitions 

This is the complete set of automatic markers supported by Power Markers. For 

instructions on using Automatic Markers, refer to Using Automatic Markers. The location of 

the Map Part containing a pre-formatted example of the automatic marker is also shown. 

Topic Assets 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Assets) 

Automatic marker Abbreviation Marker applied if... 

$attachment $at 
Topic has one or more attached 
files 

$notes $nt Topic has Topic Notes 

$duration $du Topic has a duration defined 

$resources $rs Topic has resources defined 

$resources:is:abc $rs:is:abc Topic resources are "abc" 

$resources:contains:abc $rs:ct:abc Topic resources contain "abc" 

$resources:startswith:abc $rs:sw:abc Topic resources start with "abc" 

$resources:endswith:abc $rs:ew:abc Topic resources end with "abc" 

$priority $pr 
Topic has a non-zero priority 
defined 

$relationship $rl 
Topic is at one end of a 
relationship 

$comments $cm Topic has review comments 

$image $im Topic has an embedded image 

$businesstopic $bt Topic is a Business Topic 

$xmacro $xm 
Topic contains an X-Macro 
(embedded MindManager macro) 

Topic Mark-up 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Mark-up) 

Automatic marker Abbreviation Marker applied if... 

$boundary $bd Topic has a boundary 

$frame $fr Topic has a frame 

$fontcolor $fn Topic has a non-automatic font color 

$fillcolor $fc Topic has a non-automatic fill color 
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Topic Type 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Type) 

Automatic marker Abbreviation Marker applied if... 

$activelegend $al Topic is a Power Markers Active Legend topic 

$centraltopic $ce Topic is the Central Topic 

$maintopic $ma Topic is a Main Topic 

$floatingtopic $ft Topic is a Floating Topic 

$callouttopics $co Topic is a Callout Topic 

$summarytopic $su Topic is a Summary Topic (a Callout on a Boundary) 

$level:2 $lv:2 
Topic is a level 2 topic. The value can be from 0 upwards. Level 0 
is the central topic, floating topics and callout topics. Level 1 is the 
Main Topics. Level 2 and above are subtopics. 

Topic Label 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Label) 

Automatic marker Abbreviation Marker applied if... 

$label $lb Topic has a topic label 

$label:startswith:abc $lb:sw:abc Topic label starts with the text "abc" 

$label:contains:abc $lb:ct:abc Topic label contains the text "abc" 

$label:endswith:abc $lb:ew:abc Topic label ends with the text "abc" 

$label:is:abc $lb:is:abc Topic label is "abc" 

Topic Text 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Text) 

Automatic marker Abbreviation Marker applied if... 

$text:bold $tx:bo Topic text is bold and this is not part of the default style 

$text:italic $tx:it Topic text is italic and this is not part of the default style 

$text:underline $tx:ul Topic text is underlined and this is not part of the default style 

$text:strikethrough $tx:so Topic text is struck out 

$text:is:abc $tx:is:abc Topic text is "abc" 

$text:startswith:abc $tx:sw:abc Topic text starts with "abc" 

$text:contains:abc $tx:ct:abc Topic text contains "abc" 

$text:endswith:abc $tx:ew:abc Topic text ends with "abc" 
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Keys (in topic text) 
(Map Parts > Mindjet Power Markers > Auto Markers > Keys) 

Automatic marker Abbreviation Marker applied if... 

$key:is:abc $ky:is:abc 
Topic text is "abc". The topic text is removed when the marker 
is applied 

$key:startswith:abc $ky:sw:abc 
Topic text starts with the key text "abc". The key text is stripped 
from the start of the topic text when marker is applied 

$key:contains:abc $ky:ew:abc 
Topic text contains the key text "abc". The key text is removed 
from the topic text when the marker is applied 

$key:endswith:abc $ky:ew:abc 
Topic text end in the key text "abc". The key text is stripped 
from the end of the topic text when the marker is applied 

Topic Hyperlink 
(Map Parts > Mindjet Power Markers > Auto Markers > Topic Hyperlink) 

Automatic marker Abbreviation Marker applied if... 

$hyperlink $hl Topic has a hyperlink (any type) 

$hyperlink:web $hl:ww 
Topic hyperlink points to a web page or web service (https://, 
http://, ftp://) 

$hyperlink:email $hl:em Topic hyperlink is an email address (mailto://) 

$hyperlink:file $hl:fl Topic hyperlink points to a local file 

$hyperlink:folder $hl:fd Topic hyperlink points to a local folder 

$hyperlink:topic $hl:tp Topic hyperlink points to another topic in this map 

$hyperlink:startswith:abc $hl:sw:abc Topic hyperlink starts with "abc" 

$hyperlink:contains:abc $hl:ct:abc 
Topic hyperlink contains "abc" 
Example: $hl:ct:mindjet.com/openlink will pick up Mindjet 
Catayst links 

$hyperlink:endswith:abc $hl:ew:abc 

Topic hyperlink ends with "abc" 
Example: $hl:ew:\ will pick up links to local folders 
Example: $hl:ew:.mmap will pick up links to local MindManager 
maps 

$hyperlink:is:abc $hl:is:abc Topic hyperlink is "abc" 
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Start date 
(Map Parts > Mindjet Power Markers > Auto Markers > Start Date) 

Automatic marker Abbreviation Marker applied if... 

$startdate $sd Topic has a start date defined 

$startdate:none $sd:no Topic does not have a start date defined 

$startdate:condition $sd: ... The topic start date meets the date condition (see table below) 

Due Date 
(Map Parts > Mindjet Power Markers > Auto Markers > Due Date) 

Automatic marker Abbreviation Marker applied if... 

$duedate $dd Topic has a due date defined 

$duedate:none $dd:no Topic does not have a due date defined 

$duedate:condition $dd: ... The topic due date meets the date condition (see table below) 

Either Date (Topic start date or due date) 
(Map Parts > Mindjet Power Markers > Auto Markers > Either date) 

Automatic marker Abbreviation Marker applied if... 

$date $dt Topic has either a start date or a due date defined 

$date:none $dt:no Topic does not have either a start date or a due date defined 

$date:condition $dt: ... 
Either the topic start date or due date meet the date condition 
(see table below) 

Both Dates (Topic start date and due date) 
(Map Parts > Mindjet Power Markers > Auto Markers > Both dates) 

Automatic marker Abbreviation Marker applied if... 

$dates $ds Topic has both a start date and a due date defined 

$dates:none $ds:no Topic does not have both a start date and a due date defined 

$dates:condition $ds: ... 
The topic start date and due date both meet the date condition 
(see table below) 
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Task status 
(Map Parts > Mindjet Power Markers > Task Info > Task status) 

Automatic marker Abbreviation Marker applied if... 

$task:part $tk:pt 

Topic does not have a progress value, but has other 
task fields such as a priority, duration, resource or 
date. This marker could be used to clean up maps 
to ensure that all tasks are properly marked so that 
they can be tracked 

$task $tk 
Topic has a progress value from 0% to 100% 
inclusive 

$task:unstarted $tk:us Topic has a progress value of 0% 

$task:started $tk:st 
Topic has a progress value greater than 0% but less 
than 100% 

$task:incomplete $tk:ic Topic has a progress value of less than 100% 

$task:complete $tk:cp Topic has a progress value of 100% 

$task:priority $tk:pr 
Topic has a progress value and has a non-zero task 
priority defined 

$task:priority:none $tk:pr:no Topic has a progress value and has no task priority 

$task:duration $tk:du 
Topic has a progress value and has a task duration 
defined 

$task:duration:none $tk:du:no Topic has a progress value and has no task duration 

$task:resources $tk:rs 
Topic has a progress value and has task resources 
defined 

$task:resources:none $tk:rs:no 
Topic has a progress value and has no task 
resources 

$task:resources:is:abc $tk:rs:is:abc Topic has a progress value and resources are "abc" 

$task:resources:contains:abc $tk:rs:ct:abc 
Topic has a progress value and resources contain 
"abc" 

$task:resources:startswith:abc $tk:rs:sw:abc 
Topic has a progress value and resources start with 
"abc" 

$task:resources:endswith:abc $tk:rs:ew:abc 
Topic has a progress value and resources end with 
"abc" 
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Task start date 
(Map Parts > Mindjet Power Markers > Task Info > Task start date) 

Automatic marker Abbreviation Marker applied if... 

$task:startdate $tk:sd Topic is a task and has a start date defined 

$task:startdate:none $tk:sd:no Topic is a task and does not have a start date defined 

$task:startdate:overdue $tk:sd:od 
Topic is an incomplete task and the start date is overdue: 
see detailed explanation below* 

$task:startdate:overdue:X:day $tk:sd:od:x:dy 
Topic is an incomplete task and the start date is up to X 
days overdue. You can also use "week" (wk), "month" 
(mo) or "year" (yr) in place of "day". 

$task:startdate:condition $tk:sd: ... 
Topic is a task and the start date meets the date condition 
(see table below) 

* Overdue task start dates 

A task start date can be classed as "overdue" for several reasons. The long definition is: 

the start date is ranked as overdue if there is insufficient time left to complete the task, 

given the time left to the due date (if present), the stated duration (if present) and the 

current progress value. So a task that takes 10 days and is currently 25% complete, with 

three days to go to the due date, is considered to have an overdue start date. This is 

sometimes called "at risk" in project management. If the same task were 75% complete 

instead, then it would not be overdue, as it could potentially be finished in time. 

The full list of overdue start date conditions is: 

1. The start date has passed, and the task is still 0% complete, i.e. is not started at all. 

This applies regardless of any duration or due date. 

2. The progress is too low, based on the difference between the original start date and 

due date, and the time left to go to the due date, when no duration has been given. 

3. The progress value is too low, based on the stated task duration, and the time left to 

go to the due date. 

4. The stated duration is longer than the difference between the start date and the due 

date. This will cause future tasks to be shown as "overdue" before they have even 

started, giving you early warning of a potential problem. 

Note that Power Markers is not a fully fledged project management tool, and is not capable 

of taking into account factors such as vacation time, multiple resources or loading. 

Indications of overdue start date are approximate, and always pessimistic. 



Reference 

 User Guide - 74 

Task due date 
(Map Parts > Mindjet Power Markers > Task Info > Task due date) 

Automatic marker Abbreviation Marker applied if... 

$task:duedate $tk:dd Topic is a task and has a due date defined 

$task:duedate:none $tk:dd:no Topic is a task and does not have a due date defined 

$task:duedate:overdue $tk:dd:od Topic is an incomplete task and the due date has passed 

$task:duedate:overdue:X:day $tk:dd:od:x:dy 
Topic is an incomplete task and the due date is up to X 
days overdue. You can also use "week" (wk), "month" (mo) 
or "year" (yr) in place of "day". 

$task:duedate:condition $tk:dd: ... 
Topic is a task and the due date meets the date condition 
(see table below) 

Task - either date (start date or due date) 
(Map Parts > Mindjet Power Markers > Task Info > Task - either date) 

Automatic marker Abbreviation Marker applied if... 

$task:date $tk:dt Topic is a task and has either a start date or a due date  

$task:date:none $tk:dt:no Topic is a task and does not have either a start or due date 

$task:date:overdue $tk:dt:od 
Topic is an incomplete task and has either an overdue start 
date (see above) or an overdue due date (see above) 

$task:date:overdue:X:day $tk:dt:od:x:dy 
Topic is an incomplete task and either the start date or the due 
date are up to X days overdue. You can also use "week" (wk), 
"month" (mo) or "year" (yr) in place of "day". 

$task:date:condition $tk:dt: ... 
Topic is a task and either the start date or the due date meet 
the date condition (see table below) 

Task - both dates (start date and due date) 
(Map Parts > Mindjet Power Markers > Task Info > Task - both dates) 

Automatic marker Abbreviation Marker applied if... 

$task:dates $tk:ds 
Topic is a task and has both a start date and a due date 
defined 

$task:dates:none $tk:ds:no 
Topic is a task and does not both a start date and a due date 
defined 

$task:dates:overdue $tk:ds:od 
Topic is an incomplete task and has both an overdue start 
date (see above) and an overdue due date (see above) 

$task:dates:overdue:X:day $tk:ds:od:x:dy 
Topic is an incomplete task and both the start date and the 
due date are up to X days overdue. You can also use "week" 
(wk), "month" (mo) or "year" (yr) in place of "day". 

$task:dates:condition $tk:ds: ... 
Topic is a task and both the start date and the due date meet 
the date condition (see table below) 
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Date Conditions 

The date conditions are prefixed by $startdate:, $duedate:, $date:, $dates:, 

$task:startdate:, $task:duedate:, $task:date: or $task:dates: 

Example: "$startdate:next:week" will pick up topics with a start date in next week 

Date condition Abbreviation Qualifying dates 

yesterday yd Yesterday 

today td Today 

tomorrow tm Tomorrow 

past ps Before today 

future ft After today 

past:day ps:dy Before yesterday 

future:day ft:dy After tomorrow 

5:day 5:dy 
From today to +/- 5 days. You can use any positive or negative number, 
e.g. -4 for the last 4 days 

past:week ps:wk Before the previous calendar week 

last:week ls:wk In the previous calendar week, from Monday to Sunday inclusive 

this:week th:wk In the current calendar week, from Monday to Sunday inclusive 

next:week nx:wk 
In the next calendar week, from the next Monday to the following 
Sunday inclusive 

future:week ft:wk After the next calendar week 

5:week 5:wk 
From today to +/- 5 weeks. You can use any positive or negative 
number, e.g. -4 for the last 4 weeks 

past:month ps:mo Before the previous calendar month 

last:month ls:mo In the previous calendar month 

this:month th:mo In the current calendar month 

next:month nx:mo In the next calendar month 

future:month ft:mo After the next calendar month 

5:month 5:mo 
From today to +/- 5 months. You can use any positive or negative 
number, e.g. -4 for the last 4 months 

past:quarter ps:qt Before the previous calendar quarter 

last:quarter ls:qt In the previous calendar quarter 

this:quarter th:qt In the current calendar quarter 

next:quarter nx:qt In the next calendar quarter 

future:quarter ft:qt After the next calendar quarter 
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past:year ps:yr Before the previous calendar year 

last:year ls:yr In the previous calendar year 

this:year th:yr In the current calendar year 

next:year nx:yr In the next calendar year 

future:year ft:yr After the next calendar year 

5:year 5:yr 
From today to +/- 5 years. You can use any positive or negative 
number, e.g. -4 for the last 4 years 

past:fyear ps:fy 
Before the previous financial year. The dates for the financial year are 
set in the Power Markers Options dialog. 

last:fyear ls:fy 
In the previous financial year. The dates for the financial year are set in 
the Power Markers Options dialog. 

this:fyear th:fy 
In the current financial year. The dates for the financial year are set in 
the Power Markers Options dialog. 

next:fyear nx:fy 
In the next financial year. The dates for the financial year are set in the 
Power Markers Options dialog. 

future:fyear ft:fy 
After the next financial year. The dates for the financial year are set in 
the Power Markers Options dialog. 

Additional notes on dates: 

1.      Calendar weeks are assumed to start on Monday and finish the following Sunday. This 
may be made configurable in future versions. 

2.      "yesterday" is equivalent to "last:day" 

3.      "today" is equivalent to "this:day" 

4.      "tomorrow" is equivalent to "next:day" 

5.      "X:week", "X:month" and "X:year" (where X is a positive or negative number) do not 

refer to calendar weeks, months and years, but to relative time periods. So 

"startdate:2:year" covers the period from now to now + 24 months, and not "this 

year, next year and the year after" as whole years. By contrast, a calendar year would 

be from 1st January to 31st December 

6.      "0:day", "0:week", "0:month" and "0:year" are all equivalent to "today" 

7.      "X:quarter" is not implemented 

8.      "X:fyear" is not implemented 
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System Requirements 

Mindjet Power Markers requires Mindjet MindManager Version 8 for Windows, or Mindjet 

MindManager Version 9 for Windows 

Other versions or editions of MindManager are not supported. 
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